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SSOOLLUUTTIIOONNSS  TTOO  TTHHEE  QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMMSS  
TTHHAATT  CCPPAASS  MMOOSSTT  FFRREEQQUUEENNTTLLYY  EENNCCOOUUNNTTEERR  

  

QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM:: You receive fatal error messages from QuickBooks, or you notice 
errors on reports, invoices, bills, etc.  You are missing transactions or items are missing off 
reports or lists. 

SSOOLLUUTTIIOONN: You should run Verify Data to check for damage whenever QuickBooks appears to 
be functioning improperly or erroneously. The Verify Data utility detects data damage, and then 
logs any errors it finds in a file named Qbwin.log. The Qbwin.log file is contiguous, so that 
every time you verify, rebuild, condense, or update your data, any integrity issues found will be 
appended to the end of the Qbwin.log file. It is common for the Qbwin.log to become very large. 
You can identify only current errors in the data file by renaming the Qbwin.log file, located in 
your QuickBooks directory, to Qbwin.old. QuickBooks will create a new Qbwin.log file to store 
the results of the utility you ran most recently.  To run the Verify Data utility:  

1. From the QuickBooks Windows menu, choose Close All.  

2. From the File menu, choose Utilities, and then choose Verify Data.  

3. If the Verify Data operation completes with the message QuickBooks detected no 
problems with your data, then your data is clear.  

4. If the Verify Data completes with the message “Your data has lost integrity...,” then there 
is damage in the file, and QuickBooks will display a message with instructions for 
running the Rebuild Data utility to attempt to repair the damage. The Rebuild Data utility 
should never be run across a network. Before starting the Rebuild Data process, the file 
information from the Product Information window should be noted for future reference 
(press Ctrl + 1 to open the Product Information window).  If the file is on a network, it 
should be copied locally before the Rebuild Data utility is run.  You will be prompted to 
make a backup as part of the Rebuild Data process.  Make sure that you do not overwrite 
your existing backup.  The Rebuild Data utility will run as soon as the backup completes, 
and it should only be run once.  When the Rebuild process has finished, close your 
company file and then reopen it in order to refresh the lists in the file. Note: It is a good 
idea to run Verify Data again after the Rebuild Data process to check for remaining 
damage. 

5. If the Verify Data run after rebuilding the file indicates that there is still damage, you 
should consider restoring a recent backup of your company file.  Make sure that you do 
not overwrite your existing company file.  From the File menu, choose Restore.  Any 
information entered in the company file since the backup was made will need to be 
manually reentered after you restore.  
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QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM:: QuickBooks run slowly in multi-user mode. 

  
SSOOLLUUTTIIOONN: QuickBooks can run slowly in multi-user mode for several reasons as follows:  

• The data file size is too large to be handled efficiently by the system.  

• There are three or more users accessing one module at the same time.  

• A large report is being run (for example, Transaction report) in data files with more 
than 32,000 targets.  

• The data file is located on a slow computer.  

• The Audit Trail is turned on.  

• A Network Interface Card (NIC) is slow or defective. 

 

To resolve this issue, try one or more of these measures:  

• Condense the data file.  

• Limit the number of users accessing a module at any one time.  

• Narrow the date range on a large report.  

• Locate the data file on the fastest machine on the network.  

• Turn off the Audit Trail.  

• Upgrade to faster Network Interface Cards, cables, and hubs. 
 

QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Trouble backing up a QuickBooks company data file.  

SSOOLLUUTTIIOONN::  If you use the built-in QuickBooks backup utility, you need to be in Single-user 
Mode to use the back up feature. The QuickBooks backup compresses data into a compact file 
that has the same file name as the company data file, but with the extension .qbb, rather than 
.qbw.  If you are backing up to a disk that already contains a file with the same name, the 
following message will appear: The backup file you chose already exists. Do you want to replace 
it? We recommend that you back up to a different name each time, preserving older back ups 
permanently in case they are ever needed. 
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QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM:: Trouble mapping a network drive in Microsoft® Windows® 9x, 
NT® or Millennium Edition.  

SSOOLLUUTTIIOONN:: You can only map a folder that is shared. For example: If a user on Computer 1 
shares his or her C: drive, you will only be able to map the C: drive, not the subfolders contained 
within the C: drive. If you do not see the option Map Network Drive when you right-click the 
folder containing your company file, you will need to move up a level and check the higher-level 
folder (or the drive itself) for the mapping option. If you do not see the option, please check with 
your system administrator. 

You should not map a network drive if your company file resides on the same computer where 
you are using QuickBooks – this will cause QuickBooks to operate slower. Instead, open the file 
from the drive where the data file resides. The default installation location is C:\Program 
Files\Intuit\QuickBooks. Navigate through the local C: drive and the appropriate folder levels to 
open your company file. To map a network drive from within QuickBooks:  

• From the QuickBooks File menu, choose Open Company.  

• Select Network Neighborhood from the Look in drop-down list.  

• Double-click the computer where the company file resides.  

• Right-click the folder containing the company file, and select Map Network Drive.  

• Select an unassigned drive letter. Windows defaults to the first available letter, but you 
can choose any drive letter that is unassigned.  

• Select Reconnect at Logon.  

• Click OK.  

• From the Look in drop-down list, select the drive letter you assigned, and then in the 
main window, choose your company file name and click Open.  

• When the company file opens, press Ctrl+1 to open the Product Information window. 
Look at the path provided under Location in the File Information area. The location of 
your file should be something like: 

G:\QuickBooks Pro\[company name].qbw. 

 
 You can also map a network drive within Windows Explorer as follows:  

• Right-click the Microsoft® Windows® Start button, and choose Explore.  

• Scroll down the left side of Windows Explorer to Network Neighborhood.  

• Double-click Network Neighborhood to expand the network view on the right side.  

• Double-click the computer where the company file resides.  
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• Right-click the folder containing the company file, and select Map Network Drive.  

• Select an unassigned drive letter. Windows defaults to the first available letter, but you 
can choose any drive letter that is unassigned.  

• Select Reconnect at Logon.  

• Click OK.  

• Start QuickBooks, and from the File menu, choose Open Company.  

• From the Look in drop-down list, select the drive letter you assigned, and then in the 
main window, choose your company file name and click Open.  

• When the company file opens, press Ctrl+1 to open the Product Information window. 
Look at the path provided under Location in the File Information area. The location of 
your file should be something like: 

G:\QuickBooks Pro\[company name].qbw.  
 
  

QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::   You need to rebuild a QuickBooks company data file.  

SSOOLLUUTTIIOONN:: You should run the Rebuild Data utility if you receive the message that the Verify 
Data utility has failed, if the Verify Data utility returns a b-check error, or if a QuickBooks Help 
& Support Knowledge Base article calls for a data rebuild to fix errors. The Rebuild Data utility 
will attempt to fix damage in a QuickBooks data file. If the file is on a network drive, copy the 
file locally before attempting to run this utility.  Follow these steps to rebuild the data file:  

• From the QuickBooks Window menu, choose Close All.  

• From the QuickBooks File menu, choose Utilities, and then choose Rebuild Data.  

• Rebuilding requires that you back up your company file. Click OK on the message 
informing you that a backup must be made.  

• Do not replace your current backup. Instead, use a different 3.5-inch disk (or other 
media) for this backup, or back up to your hard disk. Click No if you see a message 
asking if you want to replace the backup file. To avoid overwriting your current file, 
enter a new name in the Filename field.  

• At the bottom of the Back Up Company File window, click Back Up.  

• The Rebuild Data utility will begin as soon as the backup is complete. Click OK on the 
message informing you that the rebuild has completed.  

• Close your company data file and then reopen it to refresh the lists in the file:  

⇒ From the File menu, choose Close Company.  
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⇒ From the File menu, choose Open Company.  

⇒ Select the company you want to open, and then click Open.  
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM:: You receive the following message while trying to start 
QuickBooks, and when no one else is using the company file: “The company file has been 
opened by another user. Ask that user to switch to multi-user mode so that you can use the 
company file.” Microsoft® Windows® 98 and Millennium Edition will display the message: 
"Cannot access this file. Check security privileges over the network drive." 

SSOOLLUUTTIIOONN:: This situation can occur if the computer you are using has either Microsoft® 
Windows® 2000 or XP as the operating system – the permissions to the shared folder where the 
QuickBooks company file resides may be set to Read Only.  The default permissions are 
Everyone = Read.  To resolve this problem, the share permissions need to be changed to give 
QuickBooks users "full control" access to the shared folder where the company file resides. 

 

QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM:: I get the following warning when trying to use or set up online 
banking: Unable to connect. Try again later. [OL-202].  

SSOOLLUUTTIIOONN:: This error might appear on three different occasions as follows: 1. When you click 
Send in the Online Banking Center; 2. When you are attempting to add a financial institution 
during the online banking setup process; 3. If you are a CheckFree® client (on July 3, 
2002, CheckFree issued a new security certificate, and you may need to update your QuickBooks 
program). If the message occurs when you click Send in the Online Banking Center, it may 
indicate a server issue, and you should try the procedure again later. However, if you receive the 
message after repeated tries, or over an extended period, there may be a problem with your 
network configuration. Make sure that your Internet access is functioning properly outside of 
QuickBooks, and that the Internet Connection Setup is configured correctly in QuickBooks. 
Additionally, if you use firewall software, make sure it is configured to allow QuickBooks access 
to the Internet.  

If you receive the message while attempting to add a financial institution during online banking 
setup, it will be followed by a second message: "Warning: There has been an error which has 
prevented the retrieval of Financial Institution information. This may have been caused by a 
network service problem, which will prevent you from using QuickBooks Online Banking 
features. Please check your network setup and try again." This message should not prevent you 
from adding the financial institution, nor from using online banking functions, unless you are 
also signing up for Online Bill Payment. If you are acquiring Online Bill Payment, you may 
encounter a separate sign-up issue. 

QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM:: The computer stops responding while running QuickBooks. 

SSOOLLUUTTIIOONN:: The most probably cause for this problem may be that the computer may be 
running low on resources. As a short-term fix, either restart your computer or end tasks for 
specific programs that are not responding. As a long-term fix, either add more memory to the 
computer, or purchase a new computer. 
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QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM:: QuickBooks users receive the following message for an extended 
period of time when attempting to perform tasks in QuickBooks: “Waiting for company file”.  

SSOOLLUUTTIIOONN:: If one computer is running a utility, such as Verify Data, all other computers 
accessing the same company file in multi-user mode will be locked out until the process has 
finished.  If the company file is large, or if the file is stored on a computer that has slow or 
limited resources, the utility may take a long time to complete.  To allow utilities to complete in 
the shortest time possible, have all users who are not running the utility exit QuickBooks, and 
then switch to single-user mode on the remaining computer to run the utility.  (From the 
QuickBooks File menu, choose Switch to Single-user Mode.) When the utility is complete, 
choose Switch to Multi-user Mode from the File menu and have other users log in again.  

 

QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  When you attempt to open a data file that is stored on a network 
drive, you receive the error message: “This file cannot be accessed.” 
 
SSOOLLUUTTIIOONN:: Make sure you have security privileges on the network drive.  It could be that the 
"File and printer sharing for Microsoft Networks" component is installed on Microsoft® 
Windows® 95 or 98, and the data file is being opened from a shared folder that was set up with 
read-only access. To resolve this issue, change the shared folder's access type to “Full Control” 
on the computer that the shared folder is stored on.  
 
 

QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM:: You receive the following error message that occurs when 
restarting the computer: “An error occurred while reconnecting [drive letter] to [folder path].” 
 
SSOOLLUUTTIIOONN:: This problem is usually caused when you rename the folder where the QuickBooks 
company data file is stored. To resolve this error, on your desktop, right-click the Network 
Neighborhood or My Network Places icon and choose Disconnect Network Drive. A list of 
mapped drives will appear in the Disconnect Network Drive window. Select the drive noted in 
the error message. Click OK. The next time you start your computer, you should not receive this 
message. 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM:: You receive the following error message while attempting to send 
online payments: “Unexpected Error: OL 206” 
 
SSOOLLUUTTIIOONN:: Your financial institution or CheckFree® may be experiencing server difficulties, 
or your company file may be in an "error recovery" status. Contact your financial institution 
or CheckFree at (630) 692-3030 to learn if they are experiencing server difficulties, or to have 
them clear the "error recovery" status from your company file. To find your financial 
institution's contact number: From the QuickBooks Banking menu, choose Online Banking 
Center. From the Financial Institution drop-down list, select your financial institution. 



 

Copyright 2005, AdvisorCPE – www.QuickBooksAdvisor.info   113399  

Click Contact Info. Call the Customer Service phone number listed in the QuickBooks 
Information window to confirm the server status.  
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  You receive the following message when attempting to log in to a 
company data file as Administrator: “The QuickBooks Administrator is editing the user 
information for user (Admin). You can try to log in as a different user.” 
 
SSOOLLUUTTIIOONN::  Various situations may cause this message to appear. For example, another user 
may already be logged in as Administrator (Admin). A temporary image file has not refreshed 
properly. The User list is damaged. To resolve this issue, use a name other than Admin to log in 
to the company data file. From the QuickBooks Company menu, choose Set Up Users. If Admin 
(logged on) appears in the User List window, another user has already logged in as 
Administrator. The other user must log off before you can log in as Administrator. If Admin 
(logged on) does not appear in the User List window, click Close. On each workstation, 
including the one that you are trying to log in from, exit QuickBooks and all other programs that 
are running. Turn off each workstation by choosing Shut Down from the Microsoft® Windows® 
Start menu, selecting Shut down from the drop-down list, and then clicking OK.  
 
Important: Do not select Restart from the drop-down list. After all workstations have been turned 
off, turn them on again. Restart QuickBooks on your workstation and then try to log in as 
Administrator. If the message persists, try restoring a recent backup copy of your company file 
(however, you will need to reenter any new information that was entered since the backup was 
made).  
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM:: You receive the following runtime errors, which occur after 
installing QuickBooks: 
 

Runtime error -91  
Runtime error -2147418105  
Runtime error: 429 Active X components cannot create object  
Runtime error ID = 1AD  
Runtime error ID = 1CE 

 
SSOOLLUUTTIIOONN::  The possible cause of this problem may be caused by incomplete registration of all 
QuickBooks files during program installation. To resolve these messages: Restart your computer, 
and then restart QuickBooks. If the message persists, search for the file reboot.bat, and then 
double-click the file in the search results. (If the search results contain multiple files named 
reboot.bat, only double-click the file in the current QuickBooks installation folder.) If the 
message persists, install QuickBooks over the existing installation. If the issue is still unresolved, 
uninstall QuickBooks, and then install the program again.  
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Trouble getting QuickBooks Pro and Enterprise Solutions to use 
Multi-user Mode. 
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SSOOLLUUTTIIOONN::  When running on a network, QuickBooks Enterprise Solutions will allow up to 10 
users to work in the same data file at the same time. When more than one person is using the 
same company file, the file is in Multi-user Mode. To set up a multi-user environment, make 
sure you have your computers connected to the network properly. Install a copy of QuickBooks 
Enterprise Solutions on each user's computer. Each user must have a unique copy of the same 
version of QuickBooks with a unique Installation Key Code. Choose a location for the 
QuickBooks company file. Be sure each user has read/write access and create/delete rights to the 
directory where the QuickBooks company file is stored. On a peer-to-peer network you may 
want to put the company file on the computer of the person who uses QuickBooks the most. This 
allows that person to have the fastest access to the file. On a Client-Server network you will most 
likely put the company file on the server. Make sure you have the network drives correctly.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Lost registration number. 
 
SSOOLLUUTTIIOONN::  To locate your registration number:  In QuickBooks, press Ctrl+1 to open the 
Product Information window. Your registration number will be located in the top left corner of 
the window. To close the Product Information window, click OK.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  You receive the following message, after downloading a patch 
from the QuickBooks Update Service? "Insufficient disk space to apply patch" followed by 
"Unable to apply patch." 
 
SSOOLLUUTTIIOONN::  This message sequence can occur when your computer has less than 62 megabytes 
(MB) of hard disk space available. To resolve this message, erase some unnecessary files to free 
up approximately 62 MB of hard disk space. In many cases, this is a good indication that a new 
computer is needed. Once your computer has more hard disk space available, you can attempt 
the update again.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Why is an Internet browser required for QuickBooks and how do I 
make sure that I have the right version loaded? 
 
SSOOLLUUTTIIOONN::  The latest versions of QuickBooks require Microsoft® Internet Explorer (IE) 
version 6.0 or higher. If you do not have the required version of IE on your computer when you 
install QuickBooks, it will be installed along with QuickBooks. If you ever need to reinstall IE, 
you can install it directly from the QuickBooks CD, or you can download and install the latest 
version from the Microsoft Website. To install IE from the QuickBooks CD: Insert the 
QuickBooks CD in the CD-ROM drive. Click Reinstall QuickBooks when the installation starts. 
(If you are asked if you want to install QuickBooks now, click Yes.) Enter your Installation Key 
Code and click Next. (The code from the previous installation should be displayed just above the 
entry field, or you can find the code on the sticker on the back of the CD envelope.) Click Next 
past the QuickBooks installation location (you will not be reinstalling QuickBooks). Select 
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Custom as the Setup Type and click Next. Clear the QuickBooks checkbox and select Internet 
Explorer 6.0. Click Next. Follow the onscreen instructions for the remainder of the installation.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  You receive the following message after choosing the type of 
business and chart of accounts in the Easy-Step Interview: “Error on line XXX: imported account 
has a duplicate account number” 
 
SSOOLLUUTTIIOONN::  If you are in the sample company and go to the Easy-Step Interview and then 
choose any type of business, QuickBooks will return the error. Click OK on the error message. 
The chart of accounts selected will be set up correctly. Intuit is aware of this issue, however, 
there is no resolution at this time.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  The check numbering sequence used for printing batch checks 
does not continue in the Write Checks window. 
 
SSOOLLUUTTIIOONN::  By design, there are two separate numbering sequences used for QuickBooks 
checks. One sequence is used for printing sequential groups (batches) of checks, whereas a 
different sequence is used for manually written checks. If you select the To Be Printed checkbox 
in the Write Checks window, the check will grouped with others for continuous (batch) printing. 
When printed, the check will be assigned a number from the sequence used for batch printing. If 
you do not select the To Be Printed checkbox, QuickBooks assigns a check number from the 
numbering sequence used for manually written checks. To correct the check number in the Write 
Checks window, double-click the incorrect check number in the No. field and then enter the new 
number (this will not affect the batch numbering sequence). After you save the corrected check, 
the next assigned check number in the Write Checks window will continue sequentially from the 
number you entered. Note: You can correct the starting check number for a batch sequence as 
well (from the QuickBooks File menu, choose Print Forms, choose Checks, and then update the 
First Check Number field). 
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  I can't see the account numbers for split detail accounts when 
printing from an account register. 
 
SSOOLLUUTTIIOONN::  If the Print Splits Detail checkbox is selected when printing from a register, 
account numbers will print for single-account transactions, but not for multiple detail accounts. 
To see account number detail, you can print a Journal report instead of printing from the register. 
To do this, from the QuickBooks Reports menu, choose Accountant & Taxes, and then choose 
Journal. Click Modify Report, and in the Columns box, clear the checkmark from Trans #, Type, 
Debit, and Credit. Also, in the Columns box, select Clr, Amount, and Balance to add these 
columns. Click the Filters tab. Select Account in the Filter list, and then select the specific 
account from the drop-down list. Under Include Split Detail? Select Yes. Select Date in the 
Filters list, and then enter the appropriate date range. Click OK. Click Print at the top of the 
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report. Memorize the report if you would like to use this setup again. Intuit is aware of this issue, 
however, there is no resolution at this time.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  QuickBooks does not consistently check spelling on forms. 
 
SSOOLLUUTTIIOONN::  If a form is printed from the Print Preview window, QuickBooks does not perform 
the spelling check, even though the preference to always check spelling may be active. 
(Preferences are found on the QuickBooks Edit menu.) To ensure that the spelling check will be 
performed, click Close in the Print Preview window, and then print directly from the form. 
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  I can't see the complete customer notes on my QuickBooks Time 
Detail report. 
 
SSOOLLUUTTIIOONN::  Time Detail reports can display 99 characters in the notes column. If the customer 
notes are longer than 99 characters, then they will not display completely. To see important 
customer note information on Time Detail reports, your notes can either be reduced in length, or 
rearranged to ensure that the most important information appears at the beginning. 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  When printing a QuickBooks report in Microsoft® Excel, the 
report header is not automatically centered. 
 
SSOOLLUUTTIIOONN::  To center the report header in Excel, change the Advanced Printing options:  
Run the report in QuickBooks. Click Excel, and then click Advanced. In the Printing options 
section of the Export Report to Excel window, select Send header to Page Setup in Excel. Click 
OK. When you print the report, the header will now be centered. Note: Excel features are not 
available in QuickBooks Basic. 
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Trouble reconciling an account in QuickBooks with its financial 
statement and what to do if you do not balance. 
 
SSOOLLUUTTIIOONN::  To reconcile a QuickBooks bank account with the bank statement, from the 
QuickBooks Banking menu, choose Reconcile. Enter or select the appropriate account in the 
Account field. Compare your statement’s opening balance with the amount shown in the 
Beginning Balance field. If you reconcile regularly and the QuickBooks Beginning Balance 
differs from the beginning balance on your statement, the discrepancy could be caused by 
clearing a transaction directly in the account register (as opposed to the Reconcile window), or 
by changing or deleting a previously reconciled transaction (see the next Problem and Solution in 
this case). Enter your statement’s ending balance in the Ending Balance field. Enter any new 
service charges, finance charges, or interest earned from your statement. Click Continue to open 
the Reconcile [Account] window. Now you are ready to reconcile individual transactions. When 
you find a transaction that matches one on the statement, click the checkmark column to clear it. 
If you click Leave in the Reconcile [Account] window before you are completely finished, 
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QuickBooks does not retain the transactions you marked. You will need to start over at step 1 the 
next time you reconcile.  For each transaction that you clear, verify that it matches the one on the 
statement. If the transaction does not match and the statement is incorrect, please contact your 
financial institution. If the statement amount is correct, double-click the transaction in 
QuickBooks to display it.  Correct the error, and then click Save & Close. Click the corrected 
transaction to clear it.  When you have finished clearing transactions, look at the Difference 
amount in the bottom right corner of the Reconcile Account window. If the amount is 0.00, click 
Reconcile Now. You have successfully reconciled the account with the statement. If the amount 
is anything other than 0.00, the account does not balance for the period of time covered by the 
statement. Choose one of the following options: (1) Start again, making sure that all amounts and 
transactions have been recorded correctly or (2) Click Reconcile Now, and then click Enter 
Adjustment to finish the reconciliation for the time being. (QuickBooks will enter an adjustment 
to your account.) Eventually, however, you should locate and correct the cause of the 
discrepancy. 
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  The beginning bank reconciliation balance in Begin 
Reconciliation window in QuickBooks does not match bank statement. 
 
SSOOLLUUTTIIOONN::  The beginning balance in the Begin Reconciliation window may be incorrect if any 
of the following have occurred: 
 
1) A transaction was cleared directly in the account register, causing the transaction to be 

excluded from the beginning balance in the Begin Reconciliation window. To include the 
transaction in the beginning balance, you must clear it in the Reconcile window. Unlike 
QuickBooks 2001 and earlier versions, transactions cleared directly in the register are no 
longer used to calculate the beginning balance for reconciliation. If you are familiar with the 
way QuickBooks formerly calculated beginning (opening) balances, the amount may be 
different than expected. A previously cleared transaction was somehow modified since the 
last reconciliation. This includes voiding or deleting a cleared transaction and changing the 
amount of a cleared transaction. 

 
2) Additionally, there may be data damage in the company data file. If so, and if you are certain 

that the discrepancy is due only to transactions cleared in the account register, choose one of 
the following options: 

 
a) Complete the reconciliation with the beginning balance discrepancy. If you ignore the 

discrepancy in the Begin Reconciliation window and click Continue to proceed to the 
Reconcile window, any transactions cleared through the register will appear and will 
already have checkmarks next to them. Use your bank statement to select all other 
cleared transactions for the period. Assuming there are no other issues, the reconciliation 
should balance correctly. Complete the reconciliation of the transactions cleared in the 
register before reconciling to the bank statement. Because the sum of transactions cleared 
in the register is causing the variance between the QuickBooks and the bank statement 
beginning balances, if you complete the reconciliation of these items, you should then be 
able to reconcile properly to the bank statement. 
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b) Enter the beginning balance from the bank statement in the Ending Balance field of the 

Begin Reconciliation window, and then click Continue to proceed to the Reconcile  
window. The transactions cleared in the register will already have checkmarks next to 
them, and the Difference amount in the lower right corner should be 0.00. Click 
Reconcile Now to finish reconciling these transactions only, and then begin the 
reconciliation process again. The QuickBooks beginning balance will now match the 
bank statement beginning balance. 

 
3) If you suspect that any transactions have been altered or deleted, choose one of the following 

options: 
 

a) Run a Reconciliation Discrepancy report. From the QuickBooks Reports menu, choose 
Banking, and then choose Reconciliation Discrepancy. Select the appropriate account, 
and then click OK to display a listing of transactions that have changed since the last 
reconciliation. 

 
b) Run a Reconciliation Detail report. From the QuickBooks Reports menu, choose 

Banking, and then choose Reconciliation Detail. Select the appropriate account, select the 
statement ending date, and then click Display to open a prior reconciliation detail report. 
Compare this report to reports printed for past reconciliations to look for differences. 
Locate the discrepancy amount. (This option will work only if the discrepancy was 
caused by a single transaction.) From the QuickBooks Edit menu, choose Advanced Find. 
Select Amount in the Filter list, select the equals (=) option, and then enter the 
discrepancy amount in the field to the right. Click Find. If a transaction is found, 
determine whether it is the transaction causing the discrepancy, and correct it as needed. 
Note: If the transaction was previously reconciled but is now uncleared, correct the status 
through the account register by clicking in the checkmark column, and then clicking 
Record to save the change. If the transaction has been marked cleared but has not been 
reconciled, see the solutions above regarding how to handle transactions cleared in a 
register. 

 
c) Run an account QuickReport: Use this report to determine if transactions have an 

incorrect cleared status. From the QuickBooks Lists menu, choose Chart of Accounts.  
Select the account you want to reconcile.  Click the Reports button at the bottom of the 
list, and then choose QuickReport. Click Modify Report, and then click the Display tab.  
Select Clr in the Columns list. Click the Filters tab. In the Filter list, select Cleared. To 
the right of the Filter list, select either Yes (to filter for cleared transactions) or No (to 
filter for uncleared transactions), and then click OK to return to the report. Look at recent 
transactions. If you see transactions incorrectly cleared or uncleared, update them in the 
account register by clicking in the checkmark column, and then clicking Record to save 
the change. (See the solutions above regarding how to handle transactions cleared in a 
register.) 

 
d) Run an Audit Trail report. This report can help identify transactions that have been 

deleted, changed, or added since the last reconciliation. A close examination of this report 
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can often help locate a problem, however, if the Audit Trail feature has not been active, 
you will not be able to see changes or deletions that occurred while the Audit Trail was 
inactive. To activate the Audit Trail feature: From the QuickBooks Edit menu, choose 
Preferences. Click the Accounting icon on the left. Click the Company Preferences tab.  
Select the Use Audit Trail option, and then click OK. To run the report, from the 
QuickBooks Reports menu, choose Accountant & Taxes, and then choose Audit Trail. 
You may need to adjust the report dates to see modifications for the appropriate time 
period. If the options listed above do not resolve the issue and you suspect damage, use 
the QuickBooks Verify Data and Rebuild Data utilities to detect and repair the damage. 

 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Transactions are missing from the Match Transactions window 
after downloading a bank statement. 
 
SSOOLLUUTTIIOONN::  There are various reasons why transactions might be missing from the Match 
Transactions window after downloading a bank statement. The transactions may not have 
reached the Intuit server yet. Your financial institution uploads transactions to the server once a 
day, and until transactions are on the server, they cannot be downloaded. Historical or older 
information may not have been sent with your statement. Financial institutions decide how far 
back historical information goes, and they will send you a confirmation letter indicating how old 
your first downloaded statement transactions will be. Additionally, the server will not hold 
statement information older than three months.  
 
The Show Matched checkbox in the Match Transactions window may have been cleared. This 
prevents matched transactions from showing on the QuickStatement.  
  
If you find transactions missing from the Match Transactions window, choose the appropriate 
solution below:  
 

If the only missing transactions are from within two business days, try the download 
again tomorrow, when the transactions may have reached the server. If you would like to 
contact your financial institution: From the QuickBooks Banking menu, choose Online 
Banking Center. Select the correct name from the Financial Institution drop-down list. 
Click the Contact Info button in the upper right corner of the Online Banking Center 
window.  

 
If the only missing transactions are your oldest transactions, in the first statement, try 
entering the missing transactions manually. All future transactions should download 
correctly. Make sure the Show Matched checkbox is selected in the Match Transactions 
window: From the QuickBooks Banking menu, choose Online Banking Center. Click 
Send (if you have not already done so) to download transactions that have occurred since 
the last time you downloaded transactions. After the download has completed, select an 
account from the Items Received From Financial Institution area. Click View to display 
the QuickStatement in the Match Transactions window. Select the Show Register 
checkbox if it is not already selected. This will allow QuickBooks to match transactions 
from your QuickStatement with those in your register. Transactions that have already 
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been reconciled will not be matched. Verify that the Show Matched checkbox is selected 
in the bottom left corner of the Match Transactions window.  
 

 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  You receive the following error, which occurs when attempting to 
send or delete an online banking transaction – C=43. 
 
SSOOLLUUTTIIOONN::  C=43 errors indicate possible damage to the data file. To resolve this issue, run the 
Verify Data utility described earlier. [If data damage is detected, you will then be prompted to 
rebuild your data file (also described earlier).] 
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Your computer stops responding when you open a transaction 
window (such as the Write Checks or Pay Bills window) or edit an online transaction in a 
register. 
 
SSOOLLUUTTIIOONN::  A possible cause of this problem could be that your financial institution's 
information may need to be updated. To update your financial institution's data: From the 
QuickBooks Banking menu, choose Set Up Online Financial Services, and then choose Online 
Financial Institutions List. Scroll through the Financial Institutions Directory Web page and 
select your financial institution. Click the Apply Now button. After the page loads, close the 
browser using the “X” in the upper right corner. You do not need to fill out the application. 
QuickBooks will connect online to receive updated online financial institution information. Once 
the transmission is complete, you should be able to use online banking functions, as well as open 
transaction windows, and edit online entries in the register. If the above did not solve the issue, 
follow the steps below completely and without interruption: From the QuickBooks Banking 
menu, choose Online Banking Center. Check for any online service notifications or e-mails, view 
and then delete them. Select the message and click View. If you want to retain this information, 
click Print to print the message for your records. Click Close to close the message window. With 
the same message selected, click Delete. Make sure any transactions in the Match Transaction 
window are either matched, added to the register, or deleted. (For more information on matching 
transactions, from the QuickBooks Help menu, choose Help Index, and then type “matching 
online transactions.”) Send any payments waiting in the Items to Send section. Back up your 
company file. Disable any accounts that use online banking and/or online bill payment services 
as follows: from the Lists menu, choose Chart of Accounts.  Select any accounts that are set up 
to use online banking. (These accounts have a lightning bolt to the left of the Type column.) 
Click the Account button and choose Edit. Click the Online Info tab. Record all online account 
information on this tab, so you can re-enter it later. Clear the Online Account Access and/or 
Online Payment checkboxes. You will receive a message "You have just disabled online services 
for this account. Do you wish to retain the online information associated with this account?" 
Click No. Repeat the steps  for any other online bank accounts. Re-enable all online accounts as 
follows: in the Chart of Accounts window, select the accounts you want to re-enable. Click the 
Account button and choose Edit. Click the Online Info tab. Re-enter all online account 
information on this tab. Select the Online Account Access and/or Online Payment checkboxes as 
appropriate. Click OK to save your changes.  
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QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  The AutoRecall feature in QuickBooks not automatically filling in 
information from the last transaction for this name. 
 
SSOOLLUUTTIIOONN::  AutoRecall memorizes the information on the first transaction recorded for a 
specific name on a given date. The information from that transaction is used on all subsequent 
transactions until a new transaction for the same name is recorded on a different date. If a second 
transaction with different information is entered on the same date, AutoRecall does not store the 
new information. To resolve this issue, either update your transactions manually, or follow these 
steps to use AutoRecall to create updated transactions for the same day: Create a new transaction 
with updated information using a future date. Click Save & New, and then click Previous. 
Change the date back to today’s date. Click Save & New again.  AutoRecall works with bills, 
checks, or credit card charges. AutoRecall does not work with purchase orders, invoices, sales 
receipts, payroll liability checks, or credit memos. In addition, AutoRecall cannot transfer 
information from one account to another. For example, if you have two checking accounts, you 
cannot write a check in the first account, and then AutoRecall the check information in the 
second account. 
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Trouble setting up custom fields. 
 
SSOOLLUUTTIIOONN::  Custom fields let you add to the information that QuickBooks tracks about your 
customers, vendors, and employees and the items that you purchase and sell.  You can add your 
own custom fields to the windows where you set up customers, vendors, employees, or items. 
Information you enter into the fields can be just for your use, or it can prefill on certain forms 
when you enter a name or item on the form.  You can also include data from custom fields in 
your reports. QuickBooks treats the information you enter into a custom field the same way it 
treats information entered into any other field. If you memorize a transaction that has a custom 
field, QuickBooks memorizes what you entered in the field along with the other details of the 
transaction. If you export a list that contains data in custom fields, QuickBooks exports that data 
along with the other data from the list. For example, if you want to track your sales by region,  
add a field titled Sales Region to the New/Edit Customer window.  Fill in the sales region for 
each customer on your Customer:Job list. Add the new Sales Region field to each form. From 
then on, a customer’s sales region prefills when you enter a sale. You can filter your reports so 
they show only sales for a particular region.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Trouble setting Outlook or ACT! to work with QuickBooks. 
 
SSOOLLUUTTIIOONN::  During the synchronization process, each name from your contact manager 
(Outlook or ACT!) needs to be selected and placed in a QuickBooks list. To assign the contact 
names to the appropriate lists in QuickBooks, from the QuickBooks Company menu, choose 
Synchronize Contacts. Follow the instructions in the wizard. Once the synchronization has 
started, you are prompted you to assign the contact name(s) to the appropriate QuickBooks list. 
Select the contact name(s) from the list. At the bottom of the window, select the appropriate list 
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in QuickBooks in which to place the contact name(s). (You can select multiple contact names by 
pressing the Ctrl key on your keyboard as you click each name. Continue to press the Ctrl key 
until all names have been selected.) Click Apply. This categorizes the contact names so that they 
will automatically synchronize with the correct QuickBooks list. After all of the names have 
been categorized, click OK to resume synchronization. When the process is complete, a 
Synchronization Complete window will appear with an option to view the Sync Log file. You 
may view the file for information on the results of the synchronization.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Problems memorizing transactions in QuickBooks. 
 
SSOOLLUUTTIIOONN::  You cannot memorize receipts or deposits of payments, bill payments, paychecks, 
time records, sales tax payments, or year-to-date (YTD) payroll adjustments. If you are entering 
the transaction information for future use and do not want to record the transaction now, click 
Clear to close the transaction window. To memorize a transaction in QuickBooks, enter the 
transaction. If the content of certain fields will change each time you recall the transaction, leave 
those fields blank. For example, your monthly utility bill should be memorized with a 
blank Amount field. From the QuickBooks Edit menu, choose Memorize. In the Name field of 
the Memorize Transaction window, enter a name that will help you recognize the transaction in 
the Memorized Transaction list. In the Detail area of the Memorize Transaction window, indicate 
how you want the transaction handled. (If you need assistance, press F1 while the Memorize 
Transaction window is open.)  Click OK to memorize the transaction.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Problems entering journal entries made in the General Journal 
Entry window. 
 
SSOOLLUUTTIIOONN::  This option is available for accountants or users who prefer the traditional system 
of accounting in which transactions are entered into a general journal. If you are not an 
accountant, you might use the general journal to transfer amounts from one income or expense 
account to another, or from one class to another. In order to complete your year-end activities, 
your accountant may instruct you to record miscellaneous journal entries in QuickBooks. To 
record a journal entry, from the QuickBooks Banking menu, choose Make General Journal 
Entry. In the Make General Journal Entry window, change the Date field, if desired. If you 
number your general journal entries, enter the number in the Entry No. field.  In the detail area, 
enter distribution lines – in the Account column, enter or select the first account in your 
transaction. If you are using an A/R (accounts receivable) or A/P (accounts payable) account, the 
first account in the general journal transaction should be the accounts receivable or accounts 
payable account. In the Debit (or Credit) column, enter the debit (or credit) amount for the 
account you selected in the previous step. (Optional) Enter a memo about the amount in the 
Memo column. The memo appears on reports that include the general journal entry. Enter or 
select the customer, vendor, employee, or other name associated with the transaction in the 
Name column (required for A/R or A/P accounts.) (Optional) If you selected an expense account 
along with a customer or job, you can make the amount billable to the customer. To avoid billing 
the customer for an expense, click the billable icon to put an “X” through it. (Optional) Assign a 
class to the amount. Repeat Steps 4a through 4f to enter distribution lines until the transaction 
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reaches a zero balance (that is, the total in the Debit column equals the total in the Credit 
column). Click Save & Close to save the journal entry and close the window, or Save & New to 
save the journal entry and create a new one.   
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Understanding and using the Opening Balance Equity account. 
 
SSOOLLUUTTIIOONN::  QuickBooks creates this account the first time you enter an opening balance for a 
balance sheet account. As you enter the opening balances, QuickBooks records the amounts in 
the Opening Balance Equity account. This ensures that you have a correct balance sheet for your 
company, even before you have entered all your company's assets and liabilities. After you have 
entered all of your opening balances, you may want to move the amount in Opening Bal Equity 
to your other equity accounts. This is an optional adjustment if you want to identify retained 
earnings or the equity of several owners. 
 
To transfer all or part of the amount, from the QuickBooks Lists menu, choose Chart of 
Accounts. Double-click the Opening Balance Equity account to open its register. Enter a transfer 
transaction – in the Account field, select the equity account that you are transferring the money 
to from the drop-down list. Enter the amount to transfer in the Decrease column of the register. 
Click Record, and then repeat steps for any other amounts you want to transfer.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Problems handling bounced checks from customers. 
 
SSOOLLUUTTIIOONN::  When a customer's check has "bounced" (returned to you for insufficient funds), 
handle it in the following manner – first, create items for tracking bounced checks and their 
associated charges if these items do not already exist in your company data file. From the 
QuickBooks Lists menu, choose Item List. Click the Item button and choose New. Select Other 
Charge from the Type drop-down list and name this item Bad Check or similar. Leave 0.00 in 
the Amount or % field and select Non from the Tax Code drop-down list. Select your bank 
account from the Account drop-down list and then click Next.  
Repeat steps to create a second item named Bad Check Charge or similar. This is for the service 
charge you will assess customers for bounced checks when you send them another invoice. 
Select an income account (such as Returned Check Charges) from the Account drop-down list. If 
the account does not exist, click the drop-down arrow and choose Add New, and add the new 
income account. Click OK to save both items.  
 
Record your bank's charges for a bounced check: From the Banking menu, choose Use Register. 
If prompted, select the appropriate bank account and click OK. Create a new transaction, naming 
it NSF Fee or similar. Enter the bank charge amount in the Payment field. In the Account field, 
enter the income account. Enter a memo if desired, and then click Record. Record a credit memo 
to reverse the original sale: From the Customers menu, choose Create Credit Memo/Refunds. 
Enter all of the items from the original invoice or sales receipt, including the sales representative 
and sales tax if applicable. Enter the Bad Check line item from Step 1.c with a negative amount. 
This amount should match the total of all the items on the credit memo, creating a credit memo 
with a zero total. Click Save & Close to record the credit memo. Choose Create Invoices from 
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the Customers menu to send the customer a new invoice, which should include all of the items 
from the original invoice, plus a line item for Bad Check Charge. If the original transaction was a 
statement charge, print a new statement charge. If the original transaction was a sales receipt, 
you still need to recreate an invoice to send to your customer.  
 
Tip: QuickBooks Pro and Premier versions have a "bounced check" letter that you can send in 
addition to the new invoice. This is one of the prewritten letters available through the Write 
Letters feature in the QuickBooks Pro and Premier versions. For more information, from the 
Help menu, choose Help Index, and then type writing letters. 
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  QuickBooks creates transactions with a date other than the current 
system date. 
 
SSOOLLUUTTIIOONN::  QuickBooks checks the system date when a company data file is opened. It does 
not continually update the date if the file is not closed. If QuickBooks is left running overnight 
with the company file open, transactions are created with the date the file was originally opened. 
To resolve this issue, close your company file and then reopen it.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  I receive the following message every time I click the Start button 
on the Time/Enter Single Activity window? “The Stopwatch always displays duration in 
hours:minutes format and reverts back to decimal format when stopped.” 
 
SSOOLLUUTTIIOONN::  If the QuickBooks time format preference is set to decimal, the message appears as 
a reminder that although the time will display in hours and minutes while recording, it will revert 
to decimals when stopped. To resolve this message, choose one of the following options: In the 
Stopwatch Time Format message window that appears, select the Do not display this message in 
the future checkbox. Change the time format preference: From the QuickBooks Edit menu, 
choose Preferences. Click the General icon, and then click the Company Preferences tab. In the 
Time Format section, select Minutes.  
Click OK to save your changes.  
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  I receive the following error message when attempting to set up 
my payroll in QuickBooks: “Error reading tax info library.” 
 
SSOOLLUUTTIIOONN::  A possible cause is QuickBooks has been installed on a non-U.S. version of 
Microsoft® Windows®. QuickBooks is designed to run on the U.S. version of the Microsoft 
Windows operating system only. Therefore you must install a U. S. version of Windows. 
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  The old tax table version number still appears after updating 
payroll. 
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SSOOLLUUTTIIOONN::  The payroll may not have updated correctly, or the computer's date and time setting 
is incorrect. To resolve this issue: First, check your computer's date and time setting and correct 
it if necessary. From the QuickBooks Employees menu, choose Get Updates, and then choose 
Get Payroll Updates. While holding down the Ctrl key, click Update. After the download is 
complete, a message will appear. Click OK. Reopen the Get Payroll Updates window (see Step 
2). Your updated tax table version should now appear at the top of the window. If the issue 
persists, select the Download entire payroll update option, and then click Update. It may take 
several minutes to download the update. After the download is complete, click OK at the 
message, and then reopen the Get Payroll Updates window to check your tax table version.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Hyperlinks are broken when QuickBooks exports employee 
summary reports to Microsoft® Excel. 
 
SSOOLLUUTTIIOONN::  In QuickBooks, employee summary reports contain hyperlinks so that you can 
access a particular employee record. When summary reports are exported to Excel, the records 
they were linked to in QuickBooks are not accessible from Excel. Do not click the hyperlinks in 
Excel. You may remove broken hyperlinks from the Excel spreadsheet. For information on how 
to remove them, please refer to the Help files in Excel. Note: Employee summary reports are 
produced by the Employee Organizer. The Employee Organizer is available only by subscription 
and is not available for QuickBooks Basic. 
 
 
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  An Internet address appears in the footer when printing an 
Employee Summary report. 
 
SSOOLLUUTTIIOONN::  The employee summary reports that you print from the Employee Organizer use 
the Microsoft® Internet Explorer Page Setup settings for printed headers and footers. To resolve 
this problem, change the Page Setup settings in Internet Explorer:  
Start Internet Explorer. From the Internet Explorer File menu, choose Page Setup. Delete or edit 
the information in the Header and Footer boxes. Note: Headers and footers can consist of both 
text and codes. Codes begin with an ampersand (&), and you can use them to print information 
that changes, such as the date or time. You can use codes alone or in combination with text that 
you type. To display information about the codes you can use in headers and footers: Click the 
Help button (the small ? at the top right of the Page Setup window). Click anywhere in the 
Header and Footer areas of the window.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Problems with leave of absence records. 
 
SSOOLLUUTTIIOONN::  Each employee can only have up to 50 historical leave of absence records. 
QuickBooks will not accept any further records. You must supplement QuickBooks with some 
other record keeping method, such as a spreadsheet. 
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QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  The screen does not return to the Edit Employee window when 
the user finishes using an Employee Organizer wizard. 
 
SSOOLLUUTTIIOONN::  When you choose any of the following in the Edit Employee window, a wizard 
starts, and the Edit Employee window closes: Raises & Promotions on the Payroll Info tab  
Process Leave or Return from Leave on the Leave of Absence tab Terminate Employee or 
Termination Details on the Termination tab. To continue making changes to an employee record, 
you will need to reopen the Edit Employee window by double-clicking on the Employee List the 
name of the employee whose record you want to edit.  
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  A blank window displayed when I choose a form or letter in the 
Employment Regulations window. 
 
SSOOLLUUTTIIOONN::  A possible cause for this problem is that Microsoft® Word is not installed on your 
computer or it is not set up as the editing program for rich text format (RTF) documents. If 
possible, install Microsoft Word on your computer or set it up as the editing program for RTF 
files (see "File types: associating extension with," in Microsoft® Windows® Help). If that is not 
possible, you can save a copy of the document and then open it with a different word processing 
program. In this case, your word processing program must be capable of editing 
RTF documents.  To save a copy of an Employment Regulations document: From the 
QuickBooks Employees menu, choose Employment Regulations. Click Forms and Letters. Click 
the link for the document you want to save. In the File Download window, select Save it to disk.. 
In the Save As window, choose where you want to save the file, and then click Save. After you 
save the file, you can edit the document with your word processing program. 
 
 
QQUUIICCKKBBOOOOKKSS  PPRROOBBLLEEMM::  Trouble importing information from another financial program 
into QuickBooks. 
 
SSOOLLUUTTIIOONN::  If you have been using another financial software product, you can import 
information from that product into QuickBooks if the product allows you to export to a 
spreadsheet or text file. You can import lists that correspond to individual transactions, budgets, 
and QuickBooks lists. To transfer transaction data from another product, the data must be in 
Intuit Interchange Format (IIF). Important notes for importing data:  All account, customer, and 
vendor names must be either added to QuickBooks before importing data, or placed in the 
spreadsheet before the transactions using them. When using the INVITEMTYPE header for item 
type, all the data in the column must be in upper case. Note: The easiest way to see and 
understand the format QuickBooks needs to import data is to export some lists from the sample 
company and view the resulting file in a spreadsheet. To create an IIF file for your company, 
choose one of the following options: Download and open one of the several sample IIF files that 
are available online. Use the existing spreadsheet headers and replace the sample data with your 
own. Then see steps below to import the data into QuickBooks. Create your own IIF file: Start 
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the spreadsheet program that contains the data that you want to import into QuickBooks. Move 
the contents of all the cells in your spreadsheet one column to the right by inserting a column so 
that the first column is blank. Please refer to the Help files in the spreadsheet program for 
instructions on inserting columns and rows. Move the contents of all the cells down one row by 
inserting a row so that the first row is blank. Check the structure of the spreadsheet. If it contains 
more than one type of list or a mixture of lists, budgets, and transactions, make sure that each 
type of information has its own block in the spreadsheet. Insert a blank row to separate the 
blocks. For example, a list of customers might fill rows 12 through 75, row 76 would be blank, 
and rows 77 through 150 would be made up of vendor information. In the first cell in the blank 
row above each block of information (row 76 in the example above), enter a keyword. Be sure to 
include the exclamation point (!). Complete the first row by adding the headings that 
QuickBooks expects to find for the information. From the QuickBooks Help menu, choose Help 
Index, type the topic importing data, and choose Creating an import file to see a list of the 
headings you can use. Make sure that the content of the columns in each block matches the 
headings you just added.  Note: If a vendor's entire address is in one column, divide it so that the 
first line of the address appears under the ADDR1 column, the second line under the ADDR2 
column, and so forth. The same can be done with customer addresses.  Save the spreadsheet as a 
text file. Click Yes to the message asking if you want to save the file as tab delimited. Search for 
the file, and then rename it with the extension .iif. Start QuickBooks. From the File menu, 
choose Utilities, and then choose Import. From the Look in drop-down list, locate the folder 
containing the new file and select the file name from the list. Click OK.  
 


